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Lab 0: Course Overview 

 

Welcome to BIOL 1401! The course is entitled: CURE: Plants and Global Change. This lab-

based course is a Course-based Undergraduate Research Experience (CURE) where you will 

learn the scientific method by immersing yourself in a semester-long research project. The goals 

of the course are to improve your understanding of the scientific method and learn the role plants 

play in ongoing future and expected global changes. 

 

The CURE will be divided into four 2-week modules, organized around the sections of a primary 

literature article: introduction, methods, results, and discussion. In the first module 

(“Introduction”), you will be introduced to the science of global change, including what we know 

and how we know it. This will be paired with lecture material during this portion of the course 

describing the role plants play in responding to and regulating global change. You will also be 

introduced to global change experiments, including a pre-developed experiment in which plants 

are grown under present day and future (high CO2 and high temperature) conditions in growth 

chambers at TTU. 

 

During the second module (“Methods”), you will learn a variety of techniques for assessing plant 

responses to climate change. This will stress aspects of plant anatomy and function that are 

difficult to see with the naked eye. Methods taught will include microscopic measurements of 

stomata, SLA, chlorophyll content estimates using SPAD, fluorescence measurements of 

photosynthetic systems, and biomass allocation to different tissues. 

 

During the third module (“Results”), you will be tasked with taking measurements on the plants 

grown under the different climate conditions. As part of this, you will be taught about replication 

and data variability. You will learn why quantification of variability is important for 

understanding the consistency of an observed response. You will learn how to analyze means 

and variances to this using simplified, easily calculable, metrics such as spread and standard 

deviation. 

 

In the fourth module (“Discussion”), you will be asked to connect your results to your 

hypotheses. As part of this, you will revisit their summaries from the first module and will be 

tasked with making a connection between their results and articles you have read. At the end of 

each module, you, as a group, will write a report in the format of a primary literature article. At 

the end of the semester, each group will piece their reports together to form a research article! 

Your group will then create a 10-minute presentation of their final report to their classmates. 
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Lab 1: “Meet and greet” and syllabus discussion 

 

Schedule 

• Introduction to the course and your teaching assistant (Dr. Smith and TA; 5 min.) 

• Rundown of the syllabus (Dr. Smith; 15 min.) 

• Ice breaker to learn more about your classmates (15 min.) 

• Go over and sign lab safety contract (TA; 10 min.) 

• Go over Daily Assignment #1 (5 min.) 

 

Preamble 

Today’s lab is designed to give you a very brief introduction about the structure of this 

semester’s BIOL 1401 labs. You are highly encouraged to read through the lab syllabus, which 

can be found on the course Blackboard site, both at the bottom of the full class syllabus on the 

BIOL 1401-001 Blackboard page and as a standalone lab syllabus on the Blackboard page for 

your lab section. Contact your teaching assistant (TA) if you have trouble finding the syllabus. 

Also contact Dr. Smith of your TA if you have questions about the syllabus. 

 

This lab is also designed to introduce you to your instructors (Dr. Smith and TA) and your 

classmates. Science doesn’t happen individually and that is also true of this course. You will 

need to use your classmates and instructors to help you succeed with your course project. To do 

this, you will need to set up a rapport with your instructors and classmates, including a reliable 

means of communication and collaboration. This should be done early in the semester (e.g., 

today!) to ensure that there are not communication breakdowns later in the semester. 
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Assignment: Daily Assignment #1 

Due: beginning of next week’s class 

 

Sign your lab safety contract and turn in during class 

 

Take pre-assessment survey 

• This should be done on Blackboard. 

• Please answer to the best of your knowledge without looking anything up. You will only 

be graded for completion. 

 

Rubric 

1. Did student sign their lab safety contract and turn it in during class to the TA? (10 points) 

2. Did student complete the pre-assessment survey? (90 points) 
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Lab 2: Introduction to global change and the class experiment, reading and searching for 

scientific literature 

 

Schedule 

• Lecture on the interaction between plants and global change (TA; 10 min.) 

• Basics of the scientific method (TA; 10 min.) 

• Introduction to the class experiment (TA; 5 min.) 

• Peer-reviewed scientific articles (TA; 5 min.) 

• Searching for and citing a scientific article using Google Scholar (TA; 10 min.) 

• Any time remaining: group practice searching for and citing a scientific article 

 

Preamble 

Plants and Global Change 

Global change includes all of the expected environmental change that are resulting and expected 

to result from human activity. This includes climate change, changes in atmospheric gas 

concentrations, and changes to chemical inputs to the environment. Plants play an outsized role 

in determining the rate and magnitude of global change. For instance, photosynthesis by plants is 

the largest flux of carbon dioxide (CO2) between the atmosphere and the Earth’s surface. 

Because CO2 is the most troublesome greenhouse gas influencing climate change, any changes to 

photosynthesis in the future could alter the rate and magnitude of global change. Plants also form 

the base of food chains, so any impact of global changes on plants will influence other organisms 

(including humans!). To put it another way, plants provide ecosystem services, or “things 

ecosystems provide that humans care about and rely on” (Figure 1) and it is therefore important 

to understand how plants will function under future, novel environments so that humans can best 

prepare for any subsequent changes to these services. 
 

Figure 1. Photosynthesis represents the largest flux of 

carbon dioxide between the atmosphere and the Earth’s 

surface and, thus, indirectly impacts climate. 

Photosynthesis can also directly impact climate. These 

climate impacts, as well as direct impacts, dictate the 

influence of photosynthesis on ecosystem services. Red 

arrows indicate aspects that we will directly address in 

this project. 

 

Plant responses and feedbacks to global change are entirely certain. Because CO2 is the substrate 

for photosynthesis, it is expected that more CO2 in the atmosphere will increase photosynthesis 

and slow climate change by removing more CO2 from the atmosphere. However, there may be a 

limit to this increase due to limitation from other resources. Warming temperatures may increase 

enzymatic processes and, thus, photosynthesis; however, this may be the reverse in environments 

that are already hot and dry. This, therefore, is an area where we scientists can help to provide 

answers! 

 

Scientific method 

Scientists address these sorts of questions using the scientific method, something we will be 

spending all semester on. The scientific method can be broken into different parts: 
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1. Ask a question 

2. Formulate a hypothesis 

3. Test the hypothesis 

4. Generate a conclusion 

5. Disseminate the results 

 

In this class, your question has already been defined as “How do plants respond to and feedback 

on global change?” Throughout the semester, you will be tasked with going through the other 

steps to try and answer this question. 

 

The class experiment 

To guide you to this answer, we have set up a global change manipulation experiment. We will 

be growing cotton (Gossypium hirsutum) plants in controlled environment chambers (Figure 2) 

that are set up at different temperature (either 15°C or 35°C) and CO2 (either 420 ppm or 840 

ppm) conditions. Note: present-day CO2 levels are around 420 ppm. You will start the semester 

by reading articles about plant responses to changes in temperature and CO2 and formulating a 

hypothesis. You will learn how to measure these responses and analyze your data to help you 

come up with a conclusion (i.e., an answer to your question!). Finally, you will write up and 

orally present your results at the end of the semester. 

 

 

Figure 2. Two of the plant growth chambers where the 

class experiment will take place. Each chamber will be set 

up with its own CO2 and temperature environment. 

 

 

 

 

 

 

 

 

Scientific literature 

Today, you will begin reading scientific literature as a means to help you formulate a hypothesis. 

Scientific literature are articles that have been “peer reviewed” by other scientists. This means 

that, once an article is written, it is sent to other experts in that field. These experts read and 

critique the article and the original authors are then asked to revise the article in response. Often 

there are many rounds of this back and forth before the article is published or rejected on the 

basis of the science being unsound. As a result, these articles are heavily vetted, and can be 

trusted to a greater degree than non-peer reviewed articles (e.g., those found in blogs, etc.). 

 

There are generally two broad categories of scientific literature: primary and secondary 

literature. Primary literature consists of articles based on a single study, such as the one you will 

perform as part of this class. These typically consist of four sections: 
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1. Introduction. This section uses previous studies to help “set the stage” for the current 

study. This section typically ends with a statement of the question and hypotheses to be 

addressed by the study. 

2. Methods. This section lays out how the experiment will be performed. There should be 

enough detail in this section to allow a future researcher to replicate the study. 

3. Results. This section presents the results of the experiments, both in words but also using 

tables and figures. 

4. Discussion. This section can be thought of as the combination of the Introduction and 

Results. In this section, the questions and hypotheses will be revisited in light of the 

results of the experiments. 

 

Secondary articles summarize the results from multiple primary articles as a review of those 

studies, but do not report on the results of new experiments. 

 

Scientists read other articles to help them formulate new hypotheses and set up new experiments. 

These articles are often used as justification for new studies, which is typically provided in the 

beginning of that article (in the “Introduction”). Web databases such as Google Scholar 

(scholar.google.com) provide links to articles that can be searched for using keywords, just as in 

a typical Google search. Articles used for justification in a new article need to be cited 

appropriately in order to give credit to the original authors. 

 

Today, your TA will provide you an article to read and summarize and ask you to find an article 

of your own. Your TA will show you how to search for and cite these articles. 
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Assignment: Daily Assignment #2 

Due: start of next week’s class 

 

Individually, read and summarize the secondary literature article assigned to you by your TA 

(Chapin III, 2003). For the article, state: 

1. The title and authors of the article as well as the journal it was published in and the year it 

was published (20 points) 

2. The main message in a single sentence (20 points) 

3. The citation for the article in APA format (10 points) 

 

Additionally, and individually, read and summarize a primary literature article that cites the 

Chapin III (2003) article. For the new article, state: 

1. The title and authors of the article as well as the journal it was published in and the year it 

was published (20 points) 

2. The main message in a single sentence (20 points) 

3. The citation for the article in APA format (10 points) 

 

All your answers should be submitted on Blackboard. 

 

Rubric 

1. For Chapin (2003), did students state the title and authors of the article as well as the 

journal it was published in and the year it was published? (20 points) 

2. For Chapin (2003), did students state the main message in a single sentence? (20 points) 

3. For Chapin (2003), did students state the 
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Lab 3: Discussion of plant traits, developing a hypothesis 

 

Schedule 

• Further discussion on global change and the class experiment (TA; 15 min.) 

• Activity: rapid fire summary of the articles each student found (30 min.) 

o ~1 minute per student 

• Lecture on plant traits (TA; 15 min.) 

• Lecture on components of a hypothesis (10 min.) 

• Assignment of plant traits (10 min.) 

• Activity: develop a hypothesis about your trait’s response to CO2 as a group (15 min.) 

and present to the class (15 min.) 

 

Preamble 

Plant traits 

Traits are measurable indices of an organism’s structure (anatomy) or function (physiology). In 

plants, structural traits include things like the size and shape of individuals and their organs, 

tissues, and cells and physiological traits include things like growth and metabolic rates. 

Quantification of these traits can help scientists understand plant anatomical and functional 

diversity as well as responses to changes in environmental conditions. These can also be used to 

understand what these changes might portend for the ecosystem services plants provide to 

humans. 

 

For the class experiment, we have grown individuals of a model species, cotton (Gossypium 

hirsutum), in pots under 4 different temperature and CO2 conditions: 

- High temperature (35°C), present-day CO2 (420 ppm) 

- Low temperature (15°C), present-day CO2 (420 ppm) 

- High temperature (35°C), future CO2 (840 ppm) 

- Low temperature (15°C), future CO2 (840 ppm) 

All plants have been well watered and fertilized to avoid water and nutrient stress, respectively. 

 

There are a variety of plant traits that could be measured to examine the impact of the treatments 

on cotton and make inferences about how plants respond and feed back to global change. You 

will learn how to measure each trait. However, your group will be assigned one of six plant traits 

to examine for your study. The traits we will focus on are: 

1. Leaf chlorophyll content (unitless). The leaf chlorophyll content is the amount of the 

molecule chlorophyll inside the leaf. The chlorophyll content is indicative of plant 

investment in the molecule chlorophyll, which is used by plants to absorb light for use in 

photosynthesis. A high chlorophyll content is indicative of a plant with a high capacity 

for photosynthesis. Chlorophyll content can be measured as a unitless index using a 

SPAD meter. 

2. Leaf quantum efficiency (µmol/µmol). The leaf quantum efficiency is a measure of how 

much light received by a leaf is used for photosynthesis. It is reported as the ratio of light 

used for photosynthesis per light provided. A high quantum efficiency is indicative of 

plant with high capacity to perform photosynthesis. Leaf quantum efficiency can be 

measured using fluorescence, which involves shining a bright light on the leaf and 

measuring how much is reflected back. 
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3. Leaf stomatal conductance (µmol/m2/s). Leaf stomatal conductance is a measure of the 

rate at which water is lost from the leaf per unit leaf area and reflects how open the 

stomata are. A high stomatal conductance is indicative of a leaf that has open stomata 

(pores in the leaf) and thus is both losing lots of water, but also taking in lots of CO2. A 

high value is associated with high rates of photosynthesis. Leaf stomata conductance can 

be measured with a porometer. 

4. Leaf stomatal density (#stomata/cm2). The leaf stomatal density is the number of stomata 

per a given area of leaf. A low stomatal density reflects a low number of stomata, and 

thus a low capacity to do photosynthesis. Stomatal density can be measured with a 

microscope. 

5. Specific leaf area (cm2/g). Specific leaf area is the area of a leaf divided by its dry weight 

and is presented in units cm2/g. Specific leaf area is indicative of a plant’s structural 

investment in leaves. A low specific leaf area indicates high investment in leaf structure. 

A high specific leaf area indicates low investment in leaf structure. Specific leaf can be 

measured with a flatbed scanner (for leaf area) and a scale (for leaf dry mass). 

6. Aboveground biomass (g). Aboveground biomass is the dry weight of the aboveground 

portion of a plant. A high biomass is indicative of a plant that assimilated and stored lots 

of carbon during its lifespan. Plant biomass can be measured with a scale. 

In two weeks, you will learn how to measure these traits in preparation for class project 

measurements later in the semester. 

 

Hypotheses 

A hypothesis has two components: 

1. The first component is a statement of what you will think will happen in a given 

experiment or, often, the answer to your primary question.  

2. The second component is your logical explanation for the expected response that you 

mentioned in the first component. 

So, more simply a hypothesis can be defined as what you think will happen and why. 

 

One of the simplest ways of writing your hypothesis is to take the two components and combine 

them using the word “because”. For instance, a hypothesis that address the question “How will 

photosynthesis respond to a decrease in water availability?” might look something like: 

 

Component 1 (what you think will happen): Photosynthesis will decrease when water availability 

decreases. 

 

Component 2 (why): Stomata close when water availability is reduced in order to reduce water 

lost through leaves. 

 

Combined full hypothesis (what you think will happen + why): Photosynthesis will decrease 

when water availability decreases because stomata close when water availability is reduced in 

order to reduce water lost through leaves. 

 

In class today, you will be asked to work as a group to develop hypotheses for the expected 

response of your group’s trait in response to elevated CO2 and present this to the class. Your 
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daily activity will be to refine this hypothesis and develop another hypothesis for the response to 

warming temperature and the combination of high temperature and CO2. 
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Assignment: Daily Assignment #3 

Due: beginning of next week’s class 

 

Produce a draft of your scientific question and three main hypotheses and attached it as a Word 

document on Blackboard. 

• This should be completed individually, although group members may work together. 

• You must show your TA your progress before leaving lab. 

 

Rubric 

1. Did students show the TA their progress on questions and hypotheses? (20 points) 

2. Did students produce a logical main question? (20 points) 

3. Did students produce 3 logical hypotheses that address the main question? (60 points) 

 

Use following format to help you out: 

 

Main question: How does ________________________ (your assigned trait) respond to 

elevated temperature and CO2? 

 

Elevated CO2 hypothesis: ________________________ (your assigned trait) will 

________________________ (hypothesized direction of change) under elevated CO2 because 

______________________________________________________________________________

______________________________________________________________________________ 

______________________________________________________________________________

______________________________________________________________________________

______________________________________________________________________________

___________________________________ (your hypothesized mechanism or “why” statement). 

 

Elevated temperature hypothesis: ________________________ (your assigned trait) will 

________________________ (hypothesized direction of change) under elevated temperature 

because 

______________________________________________________________________________

______________________________________________________________________________ 

______________________________________________________________________________

______________________________________________________________________________

______________________________________________________________________________

___________________________________ (your hypothesized mechanism or “why” statement). 

 

Elevated CO2 and temperature hypothesis: ________________________ (your assigned trait) 

will ________________________ (hypothesized direction of change) under elevated CO2 and 

temperature because 

______________________________________________________________________________

______________________________________________________________________________ 

______________________________________________________________________________

______________________________________________________________________________

______________________________________________________________________________

___________________________________ (your hypothesized mechanism or “why” statement). 
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Lab 4: Writing your Introduction section 

 

Schedule 

• Lecture on writing an Introduction (TA; 15 min.) 

• Topic sentence outline drafts and adding references (TA; 10 min.) 

• Activity: topic sentence outline draft (45 min.) 

o Must show and go over with TA before moving to writing phase 

• Writing time (40 min.) 

o Must show and go over progress with TA before leaving 

 

Preamble 

The Introduction section of a scientific article 

The Introduction section of a scientific article serves to (1) lay out the importance of the question 

to be addressed by the study and (2) explain the rationale behind the hypothesized responses. 

This is typically done using previously published peer-reviewed literature on the topic of interest. 

 

Ideally, your Introduction should start broad and finish narrow in scope. As such, you might start 

with a broad societal issue that your study will address (e.g., global change). You will want to 

briefly introduce this issue and justify why it needs to be studied. From there, you should narrow 

the focus, paragraph by paragraph, such that your Introduction ends by stating your primary 

question and hypotheses (this will be the content of your last or “ultimate” paragraph of your 

Introduction).  

 

In the paragraphs preceding the final paragraph, you will want to refer to previous literature 

articles. There are two broad ways to do this. The fist way is to make a statement that is followed 

by an in-text citation that lists the author and year of the article you are referring to. For instance, 

an example sentence might look like: 

 

Previous studies have found that elevated CO2 generally increases plant photosynthesis (Smith, 

2004). 

 

Here we have made a statement summarizing the results of a previous article by and author with 

the last name of Smith that was written in 2004. If the article had two authors (say with the last 

names of Smith and Jones), the statement and in-text citation would look like: 

 

Previous studies have found that elevated CO2 generally increases plant photosynthesis (Smith 

and Jones, 2004). 

 

If the article has more than two authors, we use the notation “et al.” which stands for “et alia”, 

which means “and others” in Latin: 

 

Previous studies have found that elevated CO2 generally increases plant photosynthesis (Smith et 

al., 2004). 

 

Each of these references you cite with in-text citations will be referenced in full in your 

“References” section at the end of your paper. 
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The last paragraph of your Introduction will introduce your primary question and hypothesis. 

This will often take the form of “Here, I asked … I hypothesized that …I also hypothesized 

that…” 

 

Today, you will work on crafting a draft of your Introduction with your group. This draft will be 

due at the beginning of next week’s class. 

 

Topic sentence outlines 

To get started on your Introduction, you will first create a topic sentence outline. A topic 

sentence outline is a list of each of the topic sentences in your article. A topic sentence is the first 

sentence of a paragraph. When read alone and in order, your topic sentences should make sense, 

have a logical progression, and give the reader a good idea of what your article is about. The 

sentences can be direct and definitive statements. The sentences that follow in that paragraph 

will be used to back up those statements. 

 

Today in class you will work with your group and TA to create a topic sentence outline for your 

Introduction. Your Introduction draft (Section Draft #1) will be due by the start of class next 

week. 

 

For your Introduction, your group should use the following structure for crafting your topic 

sentence outline, and ultimately, your section draft: 

- Paragraph 1: Introduce global change and expectations for the future. 

- Paragraph 2: Introduce plants as providers of ecosystem services (i.e., the things people 

rely on ecosystems for). 

- Paragraph 3: Introduce how plant responses to expected global changes could influence 

ecosystem services. 

- Paragraph 4: Introduce your trait. Explain why it is an important indicator of plant 

responses to global change and what may drive it to change under these global changes. 

- Paragraph 5: State your question and hypotheses (e.g., “Here, I asked … I hypothesized 

that …I also hypothesized that…”). 

 

In total, your Introduction should be concise (1-1.5 pages), but should include enough references 

to back up each statement you make (likely 4-5 references at a minimum). 
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Assignment: Section Draft #1 

Due: beginning of next week’s class 

 

Produce a draft of your Introduction and attached it as a Word document on Blackboard. 

• This should be done as a group, but will be turned in individually (as identical 

documents). 

• Please use your topic sentence outline that you completed in class to help with drafting 

this. 

• Please list the full citation for all in-text citations in your Introduction at the end of your 

Introduction. 

 

Rubric 

1. Did students produce and go over a topic sentence outline with the TA in class? (10 

points) 

2. Did students produce and go over their progress on their section draft before leaving 

class? (10 points) 

3. Did students follow the assigned structure for their section draft? (20 points) 

4. Were there citations to back up each claim in the section draft and were these correctly 

written in APA format in the text and listed at the end of the Introduction? (20 points) 

5. Was their logical flow to the section draft? (20 points) 

6. Were the hypotheses correctly written and logical? (20 points) 
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Lab 5: Techniques to measure plant traits part 1 

 

Schedule 

• Introduction to plants to measure and data entry sheet (TA; 15 min) 

• Demonstration of different measurements (TA) 

o Stomatal density (10 min) 

o Chlorophyll content and quantum efficiency (10 min) 

o Stomatal conductance (10 min) 

o Leaf area (10 min) 

• Time to rotate through measurements and enter data into data sheet (55 min) 

 

Preamble 

Scientists use measurements in order to quantify variability in certain metrics and to understand 

the drivers of this variability. Today, each group will be given two plants, one grown under high 

light and another grown under low light. Over the next two weeks, you will be asked to measure 

a variety of metrics on your plants and input your data to a class-wide data sheet. 

 

Data entry and metadata 

Often, scientists will use spreadsheets to collate and organize data (these are often termed data 

sheets). One way to set these up is to use your unit of replication, which in our case is individual 

plants, as rows in the spreadsheet. The columns are used for unique metrics associated each row 

(i.e., each individual plant). We have developed a data sheet where you can enter your data. The 

spread sheet is available for download from Blackboard. 

 

Along with the data sheet, it is useful to also have a metadata sheet. The metadata sheet contains 

a verbal explanation of each column (or metric) in the data sheet and the units for each column 

(or metric). A metadata sheet is provided for as a second tab on your data sheet, which is 

available on Blackboard. 

 

Measurement Protocols 

Today you will learn how to measure leaf area, stomatal density, stomatal conductance, 

chlorophyll content, and quantum efficiency. In next week’s lab, you will measure the dry 

weight of your plant’s leaves and stems (aboveground biomass) and the dry weight and leaf area 

of the leaf you scanned to determine the specific leaf area. Your TA will demonstrate how to 

take these measurements, and a brief protocol is also provided below for each measurement. 

 

Stomatal density 

Stomatal density (#stomata per area) is the number of stomata per leaf area. To measure this, you 

will: 

1. Place a thin layer of nail polish on the outside of a leaf. 

2. Wait ~30 min for the nail polish to dry (go and take your other measurements at this 

time). 

3. Remove the nail polish with double-sided tape and place on an empty microscope slide. 

4. At high (40x) magnification, count the number of stomata you see in the field of view. 

5. Report your count in your data sheet under the column “number_stomata.” 
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Below is a picture of a leaf peel under the microscope at 40x magnification. The “football” 

shaped cells are the guard cells that form the stomata. 

 

 
 

Stomatal conductance 

The leaf stomatal conductance is the rate at which water is lost from the leaf per unit leaf area 

and reflects how open the stomata are. To measure this, you will use a porometer. Specifically, 

you will: 

1. Push the power button to turn on the SC-1 Leaf Porometer. 

2. Press “Menu” until you are on the “Measurement” display tab. 

3. Press “Enter.” 

- If you receive an error that the initial humidity is too high, shake the sensor head 

until the indicator bar goes down and the error goes away. 

4. When prompted, clip the sensor head onto the leaf. 

5. Wait for the machine to equilibrate. 

6. Wait for the machine to take the Automatic reading. 

7. Report the conductance in mmol m-2 s-1 in your data sheet under the column 

“stomatal_conductance.” 

 

Leaf chlorophyll content and quantum efficiency 

Leaf chlorophyll content (unitless) is the amount of the molecule chlorophyll inside the leaf. 

Leaf quantum efficiency (µmol/µmol) is a measure of how much light received by a leaf is used 

for photosynthesis. It is reported as the ratio of light used for photosynthesis per light provided. 
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These metrics can be simultaneously measured using a “Multispeq” device. To measure these 

metrics, you will: 

1. Open the Photosynq app on the computer. 

2. In the “Projects” tab, click on BIOL 1401 Spring 2022 project. 

3. Click “Contribute.” 

4. Enter your plant ID. 

5. Click on “Take Measurement.” 

6. Clamp the device on your leaf. 

7. Scroll through and record “Phi2” and “SPAD” in your datasheet. 

- “Phi2” is the quantum efficiency, and it will be recorded in your data sheet under 

the column “quantum_efficiency.” 

- “SPAD” is the chlorophyll content and will be recorded in your data sheet under 

the column “chlorophyll_content.”  

 

Leaf area 

Leaf area (cm2) is the area of a given leaf. To measure leaf area, you will: 

1. Label a coin envelope with your plant id (e.g., “Plant ID: sun1”) and your lab section 

(e.g., “Section: 501). 

2. Using scissors, clip your leaf at the connection between the petiole and the blade. 

3. Place your leaf perfectly flat onto a flatbed scanner with a reference scale. 

4. Place your coin envelope (with writing down) on the scanner. 

5. Open “Epson Scan 2.” 

6. Choose “Home Mode.” 

7. Click “Preview” and view the “Normal” preview. 

8. Click “Scan.” 

9. Rename your image with the plant id (e.g., “sun1.jpg”) and move the image file to the 

folder indicated by your TA. 

10. Place the leaf in the labeled coin envelope and give this to your TA for drying. 

Note: Next week, you will use image processing software to get the area of your leaf. 

 

Aboveground biomass 

Aboveground biomass (g) is the dry weight of the aboveground portion of a plant. To measure 

aboveground biomass you will: 

1. Label a brown paper bag with your plant id (e.g., “Plant ID: sun1”) and your lab section 

(e.g., “Section: 501). 

2. Cut your plant at the base of the stem. 

3. Place plant inside the paper bag. 

Note: Next week you will weigh your dried plant. 
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Assignment: Daily Assignment #4  

Due: beginning of next week’s lab class 

 

Go over your completed data sheet with your TA during class and upload a copy of your data 

sheet as an Excel document on Blackboard. 

• This should be done individually, but group members can upload the same document. 

 

Give your leaves in labeled coin envelopes to your TA before leaving class. 

 

Give your plants in labeled brown paper bags to your TA before leaving class. 

 

Rubric 

1. Did students go over their data sheet with the TA in class? (20 points) 

2. Does data sheet have entries for two individual plants and are the plant ids, group, and 

section information correctly entered? (20 points) 

3. Does data sheet have entries for number of stomata, stomatal conductance, chlorophyll 

content, and quantum efficiency? (20 points) 

4. Did students give leaves in labeled coin envelopes to TA before leaving class? (20 points) 

5. Did students give plants in labeled brown paper bags to TA before leaving class? (20 

points) 
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Lab 6: Techniques to measure plant traits part 2 

 

Schedule 

• Recap from last week’s measurements (TA; 15 min) 

• Demonstration of different measurements (TA) 

o Leaf Area (10 min) 

o Leaf mass (10 min) 

o Specific Leaf Area (10 min) 

o Aboveground Biomass (10 min) 

• Time to rotate through measurements and enter data into data sheet (55 min) 

 

Preamble 

Scientists use measurements in order to quantify variability in certain metrics and to understand 

the drivers of this variability. Today, each group will be given two plants, one grown under high 

light and another grown under low light. Over the next two weeks, you will be asked to measure 

a variety of metrics on your plants and input your data to a class-wide data sheet. 

 

Data entry and metadata 

Often, scientists will use spreadsheets to collate and organize data (these are often termed data 

sheets). One way to set these up is to use your unit of replication, which in our case is individual 

plants, as rows in the spreadsheet. The columns are used for unique metrics associated each row 

(i.e., each individual plant). We have developed a data sheet where you can enter your data. The 

spread sheet is available for download from Blackboard. 

 

Along with the data sheet, it is useful to also have a metadata sheet. The metadata sheet contains 

a verbal explanation of each column (or metric) in the data sheet and the units for each column 

(or metric). A metadata sheet is provided for as a second tab on your data sheet, which is 

available on Blackboard. 

 

Measurement Protocols 

Today you will measure the dry weight of your plant’s leaves and stems (aboveground biomass) 

and dry weight and leaf area of the leaf you scanned to determine the specific leaf area. Your TA 

will demonstrate how to take these measurements, and a brief protocol is also provided below for 

each measurement. 

 

Leaf area 

Leaf area (cm2) is the area of a given leaf. To measure leaf area, you will: 

1. Locate your scanned image on the computer. 

2. Open the “ImageJ” application. 

3. Click “File” > “Open” 

4. Find your image. 

5. Open your image. 

6. Click the straight-line segment icon and draw a 10 cm line on your image using the scale. 

You may need to zoom in using the magnifying glass icon first. 

7. Click “Analyze” > “Set Scale” 

8. Type “10” in the “Known Distance” box. 
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9. Type “cm” in the “Unit of length” box. 

10. Check the “Global” box. 

11. Click “OK”. 

12. Using the magnifying glass tool, hold shift and click to Zoom back out to the original 

size. 

13. Click “Image” > “Type” > ”8-bit”. 

14. Click “Process” > “Binary” > “Make Binary”. 

15. Click the rectangle icon to draw a rectangle around your leaf, keeping all other objects 

outside of the rectangle. 

16. Click “Edit” > “Clear Outside”. 

17. Click “Analyze” > “Analyze Particles”. 

18. Click “Ok”. 

19. Record the “Total Area” in your datasheet under the column “leaf_area”. 

 

Leaf mass 

Leaf mass (g) is the weight of a given leaf. You will measure leaf mass on the same leaf used to 

measure leaf area, as a means of calculating the specific leaf area (cm2/g), which is the ratio of 

leaf area to leaf mass. To measure leaf mass you will: 

1. Place a weigh boat on a scale and tare the scale by pressing “→T”, such that it reads 0 

g with the weigh boat in place. 

2. Place your dried leaf from last week in the weigh boat and wait for the reading to 

stabilize. 

3. Report the weight in your data sheet under the column “leaf_mass”. 

4. Calculate the ratio of leaf area to leaf mass and record it in your datasheet under the 

column “specific_leaf_area”. 

 

Aboveground biomass 

Aboveground biomass (g) is the dry weight of the aboveground portion of a plant. To measure 

aboveground biomass you will: 

1. Place a weigh boat on a scale and tare the scale by pressing “→T”, such that it reads 0 

g with the weigh boat in place. 

2. Place your dried plant from last week in the weigh boat and wait for the reading to 

stabilize. 

3. Report the weight in your data sheet under the column “aboveground_biomass”. 
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Assignment: Daily Assignment #5 

Due: beginning of next week’s lab class 

 

Go over your completed datasheet with your TA during class and upload a copy of your 

datasheet as an Excel document on Blackboard. 

• This should be done individually, but group members can upload the same document. 

 

Rubric 

1. Did students go over their datasheet with the TA in class? (25 points) 

2. Does datasheet have entries for two individual plants and are the plant ids, group, and 

section information correctly entered? (25 points) 

3. Does datasheet have entries for leaf area, leaf mass, specific leaf area, and aboveground 

biomass? (25 points) 

4. Is data combined with data from the previous week’s lab? (25 points) 
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Lab 7: Writing your Methods section 

 

Schedule 

• Lecture on writing a Methods section (TA; 15 min) 

• Lecture on experimental design and data analysis (TA; 15 min) 

• Writing time (80 min) 

o Must show completed draft before leaving 

 

Preamble 

The Methods section of a scientific article 

The Methods section of a scientific article serves to explain to the reader everything you did to 

carry out your experiment. This includes (1) the design of the experiment and materials used, (2) 

the measurements you took and how you took them, and (3) your approach to analyzing the data. 

While you haven’t yet carried out your experiment (that is for next week), the lecture provided to 

you this week along with your preparation in previous weeks is sufficient for you to produce a 

draft of this section. 

 

Throughout the Methods, you should use active voice. For instance, and example sentence might 

look like: 

 

We planted 36 individual cotton plants in 1 L plots. 

 

You will not need to cite previous articles in the Methods section. 

 

You will need to give the reader enough information that they would be able to repeat your entire 

experiment. 

 

You should divide your Methods into three subsections in the following order: 

1. Experimental Design 

2. [Trait] Measurements 

- Replace [Trait] with your group’s trait. 

3. Data Analysis 

More information on how to write these subsections is below. 

 

Note that, while you have not yet performed all of the tasks in the Methods section, it should be 

written in past tense. 

 

Experimental Design subsection 

The Experimental Design subsection should lay out how your experiment was set up and carried 

out. This should include details about the plants you used, the treatments they were subjected to, 

and the timeframe over which the experiment was conducted. Since we did most of this for you, 

we have summarized this information for you below. You will need to put this information into 

your own words, in complete sentences separated by paragraphs. 

 

Summary of the design to help your writing:  

- 36, 1 L pots with cotton (Gossypium hirsutum) in potting mix 
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- Germination in greenhouse for 1 weeks 

o 25°C 

o 50% humidity 

- Transferred to growth chamber treatments for 3 weeks prior to measurement 

o 9 plants: low CO2 (420 parts per million), low temperature (15°C) 

o 9 plants: low CO2 (420 parts per million), high temperature (35°C) 

o 9 plants: high CO2 (840 parts per million), low temperature (15°C) 

o 9 plants: high CO2 (840 parts per million), high temperature (35°C) 

- All growth chambers had same humidity (50% RH) and light (1200 µmol m-2 s-1) 

 

[Trait] Measurements subsection 

In the trait measurements subsection, you will describe how your trait was measured. Note that 

you will only provide information on the trait assigned to your group. Provide enough detail such 

that someone without any knowledge of the project would be able to repeat it. Make sure to also 

include rationale for any decisions you will make for your measurements (e.g., how you will 

choose your leaf). 

 

Data Analysis subsection 

In the data analysis subsection, you will describe how your data will be analyzed. Your data will 

be analyzed by comparing the 95% confidence intervals (CI95%) of the trait measurements for 

each of your 4 groups. Those will be calculated using the traits measured for each of the 9 

individual plants in each group. The confidence intervals are calculated from the standard error 

of the mean (SE), which is calculated from the standard deviation of the mean (SD) as: 

 

𝑆𝐷 =  √
𝛴(𝑥 − 𝑀)2

𝑛 − 1
 

 

and  

 

𝑆𝐸 =  
𝑆𝐷

√𝑛
 

 

and  

 

𝐶𝐼95% = 𝑀 ± (𝑆𝐸 ∗ 1.96)  
 

where x is a trait value for one individual, M is the mean trait value for all individuals, and n is 

the number of individuals measured. The notation Σ indicates the summing of the term (x – M)2 

for all individuals. For simplicity, SD can be calculated with the stdev() function in Excel and M 

can be calculated from the average() function in Excel. Note that you will calculate two CI95% 

values, a high-end value and low-end value. These values describe the range within you are 95% 

confident that the true mean exists. 
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In treatments where CI95% values overlap, then we would say that the treatments do not differ for 

that trait. In cases where the CI95% values do not overlap, we would say that those treatments do 

differ for that trait. 

 

Today in class you will work with your group and TA to create a draft of your Methods section. 

You will combine your Methods draft with your Introduction (Section Draft #2) and turn this in 

by the start of class next week. 

 

For your Methods, your group should have each of the sections listed above (Experimental 

Design, [Trait] Measurement, Data Analysis. 

 

In total, your Methods section should be concise (~1 page) and written in past tense. It does not 

need to contain in-text citations. 

  



 27 

Assignment: Section Draft #2 

Due: beginning of next week’s class 

 

Produce a draft of your Introduction and Methods and attach it as a Word document on 

Blackboard. 

• This should be done as a group, but will be turned in individually (as identical 

documents). 

• Please list the full citation for all in-text citations at the end of your draft. 

 

Rubric 

1. Did students produce and go over their section draft before leaving class? (20 points) 

2. Did students follow the assigned structure for the Methods section? (20 points) 

3. Did the Methods include enough information to be able to repeat the experimental design 

and trait measurements? (20 points) 

4. Was the Methods written in past tense and was there a logical flow? (20 points) 

5. Were the Introduction and Methods combined together appropriately? (20 points) 
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Lab 8: Experimental measurement day 

 

Schedule 

• Introduction and orientation (TA; 20 min) 

• Measurement time (90 min) 

o Must show completed data sheet to TA before leaving 

 

Preamble 

Today you will be gathering your experimental data! 

 

Your group will be given a single plant and asked to measure stomatal density, stomatal 

conductance, chlorophyll content, quantum efficiency, leaf area, leaf mass, specific leaf area, and 

aboveground biomass. These will be done in the same fashion as your measurements from labs 5 

and 6. 

 

All of your data should be recorded on the data sheet provided to you on Blackboard. Please 

refer to Lab 5 in the lab manual for instructions on data entry. 

 

In class today, you will measure stomatal density, stomatal conductance, chlorophyll content, 

quantum efficiency, and leaf area. You will place the leaf that you measured for leaf area in a 

coin envelope labeled with your plant id (e.g., “Plant ID: LCHT1”) and your lab section (e.g., 

“Section: 501). You will place the aboveground part of your plant in a brown paper bag labeled 

with your plant id (e.g., “Plant ID: LCHT1”) and your lab section (e.g., “Section: 501). Next 

week, you will spend a portion of the class time weighing your leaves and aboveground biomass. 

 

For quick reference, the full measurement protocols are copied below. 

 

Before leaving class, you will need to show and go over your completed data sheet with your TA 

(see Daily Assignment 6 below). 
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Measurement Protocols 

Stomatal density 

Stomatal density (#stomata per area) is the number of stomata per leaf area. To measure this you 

will: 

1. Place a thin layer of nail polish on the outside of a leaf. 

2. Wait ~30 min for the nail polish to dry (go and take your other measurements at this 

time). 

3. Remove the nail polish with double-sided tape and place on an empty microscope slide. 

4. At high (40x) magnification, count the number of stomata you see in the field of view. 

5. Report your count in your data sheet under the column “number_stomata.” 

 

Stomatal conductance 

The leaf stomatal conductance is the rate at which water is lost from the leaf per unit leaf area 

and reflects how open the stomata are. To measure this, you will use a porometer. Specifically, 

you will: 

1. Push the power button to turn on the SC-1 Leaf Porometer. 

2. Press “Menu” until you are on the “Measurement” display tab. 

3. Press “Enter.” 

a. If you receive an error that the initial humidity is too high, shake the sensor head 

until the indicator bar goes down and the error goes away. 

4. When prompted, clip the sensor head onto the leaf. 

5. Wait for the machine to equilibrate. 

6. Wait for the machine to take the Automatic reading. 

7. Report the conductance in mmol m-2 s-1 in your data sheet under the column 

“stomatal_conductance.”  

 

Leaf chlorophyll content and quantum efficiency 

Leaf chlorophyll content (unitless) is the amount of the molecule chlorophyll inside the leaf. 

Leaf quantum efficiency (µmol/µmol) is a measure of how much light received by a leaf is used 

for photosynthesis. It is reported as the ratio of light used for photosynthesis per light provided. 

These metrics can be simultaneously measured using a “Multispeq” device. To measure these 

metrics, you will: 

1. Open the Photosynq app on the computer. 

2. In the “Projects” tab, click on BIOL 1401 Spring 2022 project. 

3. Enter your plant ID. 

4. Click on “Take Measurement.” 

5. Clamp the device on your leaf. 

6. Scroll through and record “Phi2” and “SPAD” in your datasheet. 

- “Phi2” is the quantum efficiency, and it will be recorded in your data sheet under 

the column “quantum_efficiency.” 

- “SPAD” is the chlorophyll content and will be recorded in your data sheet under 

the column “chlorophyll_content.” 

  

Leaf area 

Leaf area (cm2) is the area of a given leaf. To measure leaf area, you will: 
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1. Label a coin envelope with your plant id (e.g., “Plant ID: LCHT”) and your lab section 

(e.g., “Section: 501). 

2. Using scissors, clip your leaf at the connection between the petiole and the blade. 

3. Place your leaf perfectly flat onto a flatbed scanner with a reference scale. 

4. Place your coin envelope (with writing down) on the scanner. 

5. Open “Epson Scan 2.” 

6. Choose “Home Mode.” 

7. Click “Preview” and view the “Normal” preview. 

8. Click “Scan.” 

9. Rename your image with the plant id (e.g., “LCHT1.jpg”) and move the image file to the 

folder indicated by your TA. 

10. Place the leaf in the labeled coin envelope and give this to your TA for drying. 

11. Locate your scanned image on the computer. 

12. Open the “ImageJ” application. 

13. Click “File” > “Open” 

14. Find your image. 

15. Open your image. 

16. Click the straight-line segment icon and draw a 10 cm line on your image using the scale. 

You may need to zoom in using the magnifying glass icon first. 

17. Click “Analyze” > “Set Scale” 

18. Type “10” in the “Known Distance” box. 

19. Type “cm” in the “Unit of length” box. 

20. Check the “Global” box. 

21. Click “OK”. 

22. Using the magnifying glass tool, hold shift and click to Zoom back out to the original 

size. 

23. Click “Image” > “Type” > ”8-bit”. 

24. Click “Process” > “Binary” > “Make Binary”. 

25. Click the rectangle icon to draw a rectangle around your leaf, keeping all other objects 

outside of the rectangle. 

26. Click “Edit” > “Clear Outside”. 

27. Click “Analyze” > “Analyze Particles”. 

28. Click “Ok”. 

29. Record the “Total Area” in your datasheet under the column “leaf_area”. 

 

Leaf mass 

Leaf mass (g) is the weight of a given leaf. You will measure leaf mass on the same leaf used to 

measure leaf area, as a means of calculating the specific leaf area (cm2/g), which is the ratio of 

leaf area to leaf mass. To measure leaf mass you will: 

1. Place a weigh boat on a scale and tare the scale by pressing “→T”, such that it reads 0 

g with the weigh boat in place. 

2. Place your dried leaf from last week in the weigh boat and wait for the reading to 

stabilize. 

3. Report the weight in your data sheet under the column “leaf_mass”. 
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Calculate the ratio of leaf area to leaf mass and record it in your datasheet under the column 

“specific_leaf_area”. 

 

Aboveground biomass 

Aboveground biomass (g) is the dry weight of the aboveground portion of a plant. To measure 

aboveground biomass you will: 

1. Label a brown paper bag with your plant id (e.g., “Plant ID: LCHT1”) and your lab 

section (e.g., “Section: 501). 

2. Cut your plant at the base of the stem. 

3. Place plant inside the paper bag and give to your TA for drying. 

Next week: 

4. Place a weigh boat on a scale and tare the scale by pressing “→T”, such that it reads 0 

g with the weigh boat in place. 

5. Place your dried plant from last week in the weigh boat and wait for the reading to 

stabilize. 

6. Report the weight in your data sheet under the column “aboveground_biomass”.  
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Assignment: Daily Assignment #6 

Due: beginning of next week’s class 

 

Go over your completed datasheet with your TA during class and upload a copy of your 

datasheet as an Excel document on Blackboard. 

• This should be done individually, but group members can upload the same document. 

 

Give your leaves in labeled coin envelopes to your TA before leaving class. 

 

Give your plants in labeled brown paper bags to your TA before leaving class. 

 

Rubric 

1. Did students go over their datasheet with the TA in class? (20 points) 

2. Does datasheet have entries for one plant and are the plant ids, group, and section 

information correctly entered? (20 points) 

3. Does datasheet have entries for number of stomata, stomatal conductance, chlorophyll 

content, quantum efficiency, and leaf area? (20 points) 

4. Did students give leaves in labeled coin envelopes to TA before leaving class? (20 points) 

5. Did students give plants in labeled brown paper bags to TA before leaving class? (20 

points) 
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Lab 9: Understanding variability and comparing treatments 

 

Schedule 

• Weigh dried leaf and biomass from CO2 by temperature experiment (20 min) 

o Measurement protocols are listed below 

o Must give completed datasheet to TA 

• Lecture on variability and comparing treatments (TA; 20 min) 

• Data analysis and graphing activity using sun/shade data (70 min) 

o Must show completed assignment to TA before leaving 

 

Preamble 

Biological data can be messy! Put another way, biological data can be variable. This variation 

can be due to a variety of factors, from variability within individuals, variability across 

individuals, or variability in conditions. For example, it is highly likely that all of the 

measurements you and every group has taken this semester show different values. For example, 

take a look at this histogram of the leaf area data you all measured in the sun/shade experiment: 

 

 
 

This histogram shows binned values of all the leaf area measurements. The leaf area size bins are 

represented on the x-axis, while the number of measurements in those bins is represented in the 

y-axis as a “count.” 

 

In this experiment, we tried to minimize variability due to anything other than whether the plant 

was grown in the sun or in the shade. However, even if we break the histogram up into the sun 

and shade groups, we still find that there is variability: 
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This histogram shows binned values for the leaf area measurements from the sun-grown (top; 

yellow) and shade-grown (bottom; grey) plants. The leaf area size bins are represented on the x-

axis, while the number of measurements in those bins is represented in the y-axis as a “count.” 

 

This is perfectly normal. However, the variability indicates that we cannot determine whether 

one treatment differs from another based solely on the average (or mean) values for each 

treatment. Instead, we need to look for a signal of the treatments within all this noise. There are a 

variety of approaches to doing this. What we will do in this class, is use the data to calculate the 

range of values where we are 95% confident that the true mean for a given treatment type lies, 

also known as a 95% confidence interval. Treatments that have overlapping 95% confidence 

intervals are treatments that we have low confidence in saying they are different. Treatments 

where the 95% confidence intervals do not overlap are those where we have confidence that the 

treatment means differ. 

 

To calculate the 95% confidence interval for a given trait in a given treatment, we need to: 

 

1. Calculate the mean of that trait in that treatment type. In Excel, you can use the 

“=average()” function to calculate the mean. To do this, type “=average(“ in an empty 

cell in your datasheet and highlight all the trait values in the treatment of interest. The 
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number produced is your mean trait value for that treatment. Mathematically, this is 

calculated as: 

 

𝑀 =
Σ𝑥

𝑛
 

 

where M is the mean value of the trait, Σx is the sum of all your trait values, and n is the 

sample size (or total number of trait values). 

 

2. Calculate the standard deviation of the trait in that treatment type. In Excel, you can use 

the “=stdev()” function to calculate the mean. To do this, type “=stdev(“ in an empty cell 

in your datasheet and highlight all the trait values in the treatment of interest. The number 

produced is the standard deviation of the trait value for that treatment. Mathematically, 

this is calculated as: 

 

𝑆𝐷 =  √
𝛴(𝑥 − 𝑀)2

𝑛 − 1
 

 

where SD is the standard deviation of the trait in that treatment. 

 

3. Calculate the standard error of the trait in that treatment type. In Excel, you can do this by 

dividing the standard deviation of the trait in that treatment type from step 2 by the square 

root of the sample size. The number produced is the standard error of the trait value for 

that treatment. Mathematically, this is calculated as: 

 

𝑆𝐸 =  
𝑆𝐷

√𝑛
 

 

 where SE is the standard error of the trait in that treatment. 

 

4. Calculate the 95% confidence interval of the trait in that treatment type. In Excel, you can 

do this by multiplying the standard error of the trait in that treatment type from step 3 by 

1.96 and adding or subtracting this value from the mean calculated in step 1. The number 

produced is the 95% confidence of the trait value for that treatment. Mathematically, this 

is calculated as: 

 

𝐶𝐼95% = 𝑀 ± (𝑆𝐸 ∗ 1.96)  
 

 where CI95% is the 95% confidence interval of the trait in that treatment. 

 

The 95% confidence interval now give you a range of values for your trait where you are 95% 

confident that the true mean for that treatment lies. To test whether treatments differ, you can 

now calculate a similar value for other treatments and examine whether the 95% confidence 

intervals overlap. If the 95% confidence intervals overlap, you would indicate that it is likely 
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that the treatments do not differ for that trait. If the 95% confidence intervals do not 

overlap, you would indicate in your Results that the treatments differ for that trait. 

 

Let’s walk through an example using the trait leaf area measured in the sun/shade experiment 

from labs 5 and 6. From these data, the treatment mean (M), standard deviation (SD), standard 

error (SE), and 95% confidence interval (CI95%) of leaf area were calculated as in steps 1-4 above 

as: 

 

Treatment M SD SE CI95% 

Sun 31.38 11.20 1.95 27.56 - 35.21 

Shade 27.42 8.04 1.40 24.68 – 30.16 

 

We can now use this table to assess whether there was an effect of the treatments on leaf area. To 

do this, we compare the 95% confidence intervals for each group. While the mean is higher for 

the sun plants, the 95% confidence intervals overlap. Thus, we would conclude that the 

treatments did not have an effect on the leaf areas of the plants. 

 

To supplement tables like the one above, we can use graphs. Graphs help your audience visualize 

the effects you are stating in text and tables. Graphs come in various forms. The graph you will 

be creating is called a bar chart. This chart will show the mean values for your treatments, as 

well as the variability around those values, represented by the 95% confidence intervals. As an 

example, a bar chart for the trait leaf area in the sun/shade experiment from labs 5 and 6 might 

look like:  

 

 
where the left grey bar goes up to the mean value for the shade treatments and the right yellow 

bar goes up the to the mean value for the sun treatments. The error bars indicate the 95% 

confidence interval range. Note that the axes and ticks are labeled to indicate treatment (x-axis) 
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and trait (y-axis) information and that units are noted for the y-axis variables. This labeling is 

necessary to properly convey what is on the graph. Your TA will go over how to make a similar 

graph in Excel. 

 

Your assignment for this lab will partly consist of making a table and figure similar to the ones 

above for your assigned trait using the sun/shade data provided by your TA. See Daily 

Assignment #7 below for full information on this week’s assignment. 
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Measurement Protocols 

 

Leaf mass 

Leaf mass (g) is the weight of a given leaf. You will measure leaf mass on the same leaf used to 

measure leaf area, as a means of calculating the specific leaf area (cm2/g), which is the ratio of 

leaf area to leaf mass. To measure leaf mass you will: 

1. Place a weigh boat on a scale and tare the scale by pressing “→T”, such that it reads 0 

g with the weigh boat in place. 

2. Place your dried leaf from last week in the weigh boat and wait for the reading to 

stabilize. 

3. Report the weight in your datasheet under the column “leaf_mass”. 

Calculate the ratio of leaf area to leaf mass and record it in your datasheet under the column 

“specific_leaf_area”. 

 

Aboveground biomass 

Aboveground biomass (g) is the dry weight of the aboveground portion of a plant. To measure 

aboveground biomass you will: 

1. Place a weigh boat on a scale and tare the scale by pressing “→T”, such that it reads 0 

g with the weigh boat in place. 

2. Place your dried plant from last week in the weigh boat and wait for the reading to 

stabilize. 

3. Report the weight in your datasheet under the column “aboveground_biomass”.  
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Assignment: Daily Assignment #7 

Due: beginning of next week’s class 

 

Weigh your leaf and biomass from last week and enter the data into your datasheet for the CO2 

by temperature experiment. Go over your completed datasheet with your TA during class and 

turn in a digital copy (1 per group) to your TA. 

 

Create a summary results table and figure for your trait using the sun/shade data provided by 

your TA. Place these in a Word document along with 1-2 sentence statement describing whether 

the sun/shade treatments impacted your trait. This statement should include the concluded result 

(e.g., positive, negative, or no impact) and the reasoning you used to make this conclusion (e.g., 

how you used the 95% confidence intervals to make the comparison). Please make sure to 

indicate your trait on the Word document. 

 

Upload the Word document to Blackboard. 

 

Rubric 

1. Did students go over their CO2 by temperature datasheet with the TA in class? (20 points) 

2. Does the CO2 by temperature datasheet have entries for one plant and is the leaf weight, 

biomass weight, and specific leaf area entered correctly? (20 points) 

3. Does the sun/shade table have summary statistics for mean, standard deviation, standard 

error, and 95% confidence intervals for each treatment group? (20 points) 

4. Are the means and 95% confidence intervals plotted correctly on the sun/shade figure and 

does the plot have proper axis and tick labels? (20 points) 

5. Does the results summary statement correctly state the observed result and provide an 

explanation for how this was concluded? (20 points) 
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Lab 10: Writing your Results section 

 

Schedule 

• Lecture on writing a Results section (TA; 30 min) 

• Writing time (80 min) 

o Must show completed draft before leaving 

 

Preamble 

The Results section of a scientific article 

The Results section of a scientific article serves to present the findings from your project. 

Importantly, these are just your findings and, in this section, they are not put in context of past 

studies. Here, you will use active voice to make short, declarative statements about the impact of 

your treatments on your trait. Your Results section will be divided into three components: (1) 

paragraph explaining the results, (2) statistics table, and (3) a figure. 

 

Results paragraph 

In this paragraph, you will state the effect of the treatments on your trait and back this up with 

the statistics you calculated. There are a variety of different ways to do this. In general, you want 

to state whether there was a statistically significant difference between treatments, the 

directionality of the effect (i.e., positive or negative), and the statistics used to back up the claim. 

Using the leaf area results from the CO2 by temperature experiment, you might state something 

like: 

 

The treatments did not have a statistically significant effect on leaf area (Table 1 and Figure 1). 

This was confirmed using 95% confidence intervals, which overlapped for the high CO2, high 

temperature (CI95%: 13.48-24.59), high CO2, low temperature (CI95%: 16.19-23.21), low CO2, 

high temperature (CI95%: 13.28-21.76), and low CO2, low temperature (CI95%: 9.82-17.57) 

treatments. 

 

Because you have four treatments to compare, make sure to write about the comparison among 

all treatment types in this paragraph. 

 

Today in class you will work with your group and TA to create a draft of your Results section. 

You will combine your Results draft with your Introduction and Methods (Section Draft #3) and 

turn this in by the start of class next week. 

 

Note also that the text in this paragraph should refer to your table and figure. This can be done in 

a parenthetical after a declarative statement and serves to point the reader to the table and/or 

figure for greater context. 

 

Results table 

You will create a results table that provides the mean, standard deviation, standard error, and 

95% confidence interval for each treatment group. Using the leaf area results from the CO2 by 

temperature experiment, a table would look like: 
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Table 1. Summery statistics for each treatment* 

Treatment M SD SE CI95% 

HCHT 19.04 6.94 2.83 13.48 – 24.59 

HCLT 19.70 5.37 1.79 16.19 – 23.21 

LCHT 17.52 4.84 2.16 13.28 – 21.76 

LCLT 13.70 4.42 1.98 9.82 – 17.57 

*Key: M = mean, SD = standard deviation of the mean, SE = standard erorr of the mean, CI95% = 

95% confidence interval, HCHT = high CO2, high temperature, HCLT = high CO2, low 

temperature, LCHT = low CO2, high temperature, LCLT = low CO2, low temperature. 

 

Note the title and numbering of the table as well as the key to define any abbreviations in the 

table.  

 

Results figure 

You will create a results figure that shows the mean and 95% confidence interval for each 

treatment group in a bar graph. The main bar will go to the mean and the whiskers will indicate 

the top and bottom end of the 95% confidence interval. Using the leaf area results from the CO2 

by temperature experiment, a figure would look like: 

 

Figure 1. 

 
Figure 1. The leaf area of plants grown in the high CO2, high temperature (HCHT; blue bar), 

high CO2, low temperature (HCLT; light blue bar), low CO2, high temperature (LCHT; green 

bar), low CO2, low temperature shade (LCLT; light green bar). The height of the bars indicates 

the mean value for each treatment group. The whiskers indicate the 95% confidence interval. 

 

Note that the figure has a number on top and a legend that describes the figure in detail. 

 

For your Results, your group should have a summary paragraph, a table, and a figure. 

 

In total, your Results section should be concise (~1 page) and written in past tense. It should 

contain one table and one figure. It does not need to contain in-text citations.  
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Assignment: Section Draft #3 

Due: beginning of next week’s class 

 

Produce a draft of your Introduction, Methods, and Results and attach it as a Word document on 

Blackboard. 

• This should be done as a group, but will be turned in individually (as identical 

documents). 

• Please list the full citation for all in-text citations at the end of your draft. 

 

Rubric 

1. Did students produce and go over their section draft before leaving class? (20 points) 

2. Did the Results include a table and figure with correct data? (40 points) 

3. Were the Results from the table and figure interpreted correctly? (20 points) 

4. Were the Introduction, Methods, and Results combined together appropriately? (20 

points) 
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Lab 11: Connecting your Introduction and Results sections  

 

Schedule 

• Lecture on connecting hypotheses to results (TA; 15 min) 

• Class activity (40 min) 

o List hypotheses and present evidence for whether they were confirmed or rejected 

o Present to class 

• Lecture on connecting results to previous work (TA; 15 min) 

• Class activity (40 min) 

o List works cited in Introduction and make at least one connection between your 

result and each study 

o Show progress to TA before leaving 

 

Preamble 

To this point, you have laid the background for your study in the Introduction section, explained 

how your study was done in the Methods section, and presented your finding in the Results 

section. The final section of your paper is the Discussion section. In the discussion you will 

expand upon your results and place them in context of the background you presented in the 

Introduction. To do this, you will revisit aspects of your Introduction and use this information to 

contextualize your results. In today’s lab, you will compare your results to (1) your hypotheses 

and (2) the previous studies cited in your Introduction. 

 

Hypothesis-results comparison 

In lab 3, you developed 3 hypotheses, which have been included in each of your section drafts. 

These each stated the expected responses of your trait to the temperature and CO2 treatments, as 

well as the biological mechanisms for these expectations. Now that you have your results, your 

results, you can revisit these hypotheses to see if they were confirmed (i.e., the traits responded 

in the hypothesized way) or rejected (i.e., the treatments did not respond in the hypothesized 

way).  

 

Note that in many cases, you may not have enough information to know where the proposed 

biological mechanism was correct, and that is okay. Often times, there is only enough 

information to speculate about whether the mechanism was correct or not. We will work on this 

in next week’s lab. 

 

In this week’s lab, your first activity will be to restate each of your hypotheses and use your 

results to confirm or refute them. You will share these findings with the class. 

 

Contextualizing results using past work 

In your Introduction, you referenced past work that relates to your study. In your Discussion, you 

will want to put your results in context of those previous studies. For instance, if a previous study 

measured similar responses to you, it would be good to note whether your results matched what 

they had found. If the results differed, the Discussion is a place to speculate about why that 

might have been the case. 
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You may have also cited studies that speak to the necessity or importance of your research 

project. The Discussion is where you will want to revisit those and explain how your findings 

now move the field forward by adding a new piece to the puzzle. 

 

In lab this week, you will be asked to contextualize your results using each of the studies that 

you cited in your Introduction.  
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Assignment: Daily Assignment #8 

Due: beginning of next week’s class 

 

In this assignment, you will connect your results to your introduction in two ways (see below). 

This should be done in a Word document using complete sentences. When completed, please 

turn in your Word document on Blackboard. You may work with your group, but the document 

should be turned in individually. 

- Connection 1: For each of your hypotheses, restate the hypothesis and then state whether 

it was confirmed or rejected. The first sentence in each block of text should start “We 

hypothesized that …” and the following sentences should start “We found that …” and 

should end by stating whether this finding confirmed or rejected the hypothesis. You will 

present these connections to your classmates during the class period. 

- Connection 2: For each literature article cited in your Introduction, state how your results 

compare to the content in that article. You will show these connections to your TA before 

leaving lab. 

 

Rubric 

1. Did student present the connection between their hypotheses and results to the class? (20 

points) 

2. Did student discuss the connection between literature and their results with the TA before 

leaving lab? (20 points) 

3. In the Word document, were the hypotheses fully and correctly stated? (20 points) 

4. In the Word document, were the connections between hypotheses and results made 

correctly and backed up by the statistical results? (20 points) 

5. In the Word document, were the connections between previous literature and the findings 

made correctly and backed up by the statistical results? (20 points) 
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Lab 12: Writing your Discussion section 

 

Schedule 

• Lecture on connecting results to things people care about (TA; 15 min) 

o Ecosystem services 

o Study limitations 

o Discussion structure 

• Class activity (30 min) 

o Connect your results to an Ecosystem Service 

o Present to class 

• Lecture on study limitations and Discussion structure (TA; 15 min) 

• Writing time (50 min) 

o Must show drafts of all sections to your TA before leaving. Sections are: 

1. Evaluation of hypotheses (1 paragraph) 

2. Connection to past studies (1-2 paragraphs) 

3. Relevance to ecosystem services (1 paragraph) 

4. Study limitations (1 paragraph) 

5. Conclusions (1 paragraph) 

 

Preamble 

The Discussion section of a scientific article 

The Discussion section of a scientific article serves to place your results in a broader context. 

Last week, you did this by comparing your results to your (1) hypotheses and to (2) the literature 

you cited in your Introduction. These will help form the basis of the first two sections of your 

Discussion. There are three more sections that you will work through today: (3) connecting your 

results to an ecosystem service, (4) the limitations of your study, and (5) the concluding 

paragraph. The final structure of your Discussion will have the following subsections: 

 

1. Evaluation of hypotheses (1 paragraph) 

- Restate each hypothesis and whether it was confirmed or rejected by your results. 

2. Connection to past studies (1-2 paragraphs) 

- State whether your results were similar or different to those found by previous 

studies. If different, provide a possible reason as to why. 

3. Relevance to ecosystem services (1 paragraph) 

- Choose an ecosystem service and discuss how your results are relevant to that 

service. 

4. Study limitations (1 paragraph) 

- Discuss any actual or perceived limitations of your study. Also, mention future 

studies that could be done to alleviate those limitations. 

5. Conclusions (1 paragraph) 

- Summarize the content from the previous 4 sections of your Discussion. 

 

Your final Discussion section should be about 2 pages long (double spaced). Longer or shorter 

sections are okay, as long as the main content points above are addressed. 
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Please refer to Lab 11 of the manual for information on how to complete the first two 

subsections. Below is information about subsections 3-5. 

 

Discussion subsection on relevance to ecosystem services 

As you learned in Lab 2, plants provide ecosystem services, or “things ecosystems provide that 

humans care about and rely on.” One of the primary motivations for this study was to assess how 

future conditions (i.e., changes in temperature and CO2) might impact the ecosystem services 

that plants provide (see Figure 1 from Lab 2). 

 

There are a large number of services that ecosystems provide to humans, and they broadly fall 

into four categories: regulating services, provisioning services, supporting services, and cultural 

services: 

 

1. Regulating services 

- Air quality regulation 

- Climate regulation 

- Water quality regulation 

- Erosion regulation 

- Habitat regulation 

- Regulation of extreme weather events 

- Pollination 

2. Provisioning services 

- Food 

- Raw materials 

- Medicinal resources 

- Drinking water 

3. Supporting services 

- Nutrient cycling 

- Photosynthesis 

- Soil formation 

4. Cultural services 

- Physical and mental health benefits 

- Recreation 

- Aesthetic beauty 

- Stewardship 

- Education 

 

Plants are at the heart of many of these ecosystem services, both directly (e.g., photosynthesis, 

food) and indirectly (e.g., aesthetic beauty, soil formation). For your Discussion, you will be 

asked to produce a section that connects your Results to one ecosystem service. To do this, 

pick an ecosystem service and indicate what a future high CO2, high temperature world might 

mean for how much of that service can be provided by ecosystems. 

 

In class today, you will be asked to pick an ecosystem service and present to the class on how 

your results inform the future trajectory of this service. 
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Discussion subsection on study limitations and future directions 

Every scientific study has limitations. And this is okay! However, those limitations need to be 

addressed in the Discussion of your paper. Typically, these limitations are logistical and are 

related to the fact that time and resources are not infinite. In a paragraph, you should identify 2 

limitations of your study, stating both how they impacted the interpretation of your results and 

how you could alleviate these limitations with a future study. 

 

Discussion subsection on conclusions 

The last paragraph of your discussion is reserved for a summary of the main findings of your 

study. To achieve this, we are asking you to summarize each of the first four Discussion 

subsections in one sentence per subsection. So, your conclusions paragraph will have a sentence 

each on: (1) connection between your results and your hypotheses, (2) connection between your 

results and previous results, (3) impact of your results on the future of an ecosystem service, and 

(4) study limitations and suggestions for future work. 

 

By the end of class today, you should have a rough draft of your Discussion section, with each of 

the 5 subsections listed above completed. Please show and go over this with your TA before the 

end of class. Section Draft #4 will be due by the start of class next week (see below). 
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Assignment: Section Draft #4 

Due: beginning of next week’s class 

 

Produce a draft of your Introduction, Methods, Results, and Discussion and attach it as a Word 

document on Blackboard. 

• This should be done as a group, but will be turned in individually (as identical 

documents). 

• Please list the full citation for all in-text citations at the end of your draft. 

 

Rubric 

1. Did students present their connection to an ecosystem service in class? (20 points) 

2. Did students produce and go over their section draft with the TA before leaving class? 

(20 points) 

3. Did the Discussion include all five subsections listed above? (5 points) 

4. Were the connections in the Discussion made correctly to the hypotheses? (5 points) 

5. Were the connections in the Discussion made correctly to previous studies (5 points) 

6. Were the connections in the Discussion made correctly to an ecosystem service? (5 

points) 

7. Were at least two limitations listed and was it stated how they impacted the interpretation 

of the results and possible methods alleviate these limitations with a future study? (10 

points) 

8. Did conclusion paragraph summarize aspects of each of the first four Discussion 

subsections? (10 points) 

9. Were the Introduction, Methods, Results, and Discussion combined together 

appropriately? (20 points) 
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Lab 13: The why and how of knowledge dissemination 

 

Schedule 

• Lecture on knowledge dissemination and tips for making good presentations (TA; 20 

min) 

• Class activity: “Everyone’s a Critic” (30 min) 

o Critique presentation slides 

• Presentation slide prep time (60 min) 

o Must show draft to your TA before leaving 

 

Preamble 

Scientific knowledge and findings must be disseminated. Dissemination is the communication of 

information. This is a critical step in the scientific process because without this step, the 

knowledge and findings from a project would not be known outside of the individuals that 

performed the study. Dissemination can come via many different forms of communication. 

Scientists typically disseminate their work through at least one of two avenues: (1) written 

reports and (2) oral presentations. Throughout the semester you have been working on a written 

report. In class today, you will learn how to develop an oral presentation that will communicate 

the findings from your report. 

 

Audience 

It is important to consider your audience, or the group of people you are communicating to, when 

you begin preparing to disseminate your findings. This is important for determining how you 

will communicate your ideas. When thinking about your audience, it might be important to 

consider: 

 

1. What is the level of scientific training of the audience? 

2. How familiar is your audience with you and your work? 

3. Why is the audience likely to be interested in your work? 

4. What communication styles might best engage your audience? 

 

The answers to these questions are likely to be different for different groups. For instance, 

consider two audiences: (1) the scientific community of plant biologists and (2) community 

members attending a plant education outreach event. How would your answers to the questions 

above differ for those different groups? 

 

In your written report, you have been writing to a scientific audience, with a high level of 

training, familiarity with, and interest in your work. The audience for your oral presentation will 

be similar. So, the content of the written report and presentation can and should be similar. 

 

Oral presentations with visual aids 

An oral presentation is where your findings are verbally communicated to your audience. Often, 

it is useful to use visual aids to help convey the main messages. Note that the visual aids are 

there to supplement the information you are conveying verbally. They do not need to directly 

repeat the information you provide. They instead are used to (1) emphasize a main point or (2) 



 51 

show a point visually in a way that is not possible to show verbally. In this class, you will be 

using slides as visual aids to supplement your verbal comments. 

 

With slides, it is useful to consider the perspective of your audience. Your audience will be 

listening to you, while also viewing your slides. So, you do not want to overwhelm your slides 

with too much content or else you might risk them not paying attention to what you are saying! 

An effective slide will (1) explicitly state the main message and (2) provide a visual aid or short 

bits of supplementary text to support that message. The details can be filled in with your words. 

 

To build an effective slide, you can indicate the main message at the top of the slide and use the 

rest of the slide for the visual aid or short pieces of supplementary text. For example, a slide in 

the Results section of a presentation, might look something like: 

 

 
 

The slide contains the primary point (i.e., “Shading did not significantly change the leaf area”) 

and supplemented that with a graph showing the data to support that point. Note that there is not 

much detail on the slide, including the information that you might find in the legend of the graph. 

This is okay because the presenter can provide any important details verbally. 

 

For your slides, you should include the main message as the title at the top of the slide and 

support this message with 0-2 visual aids and/or 0-2 supporting bullet points. 

 

In class today, you will be asked to critique a slide deck and provide suggestions for 

improvement. 

 

Oral presentation length 

When developing an oral presentation, it is important to consider the time allotted to you. This 

will help determine the level of detail about a project that you can provide to an audience. In 

most cases, you will not be able to provide the same level of detail in an oral presentation that 

you would provide in a written report. 
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For your presentation in this class, you will be asked to present your findings in a maximum of 8 

minutes, which is clearly not enough time to convey all of the aspects of your written report. A 

good rule of thumb, is that each content slide will take ~1 minute to present. So, with 8 minutes, 

you should be careful not to have more than 8 content slides to avoid going over time. Those 

slides should convey: 

 

1. Why you did your study 

2. How you did your study 

3. What you found 

4. What your findings mean in a broader context 

 

Below we will provide a suggested outline for your oral presentation (and slides). You will also 

be provided a PowerPoint template on Blackboard. 

 

Suggested oral presentation outline 

In order to convey the points mentioned above, we suggest using an outline that mimics the 

outline of your written paper, with the following sections: 

 

1. Introduction 

2. Hypotheses 

3. Methods 

4. Results 

5. Discussion 

6. Conclusion 

 

You will also need a title slide at the very beginning that has your presentation title and a list of 

authors (i.e., your group members). We suggest the following sequence of slides for your 

presentation, with bolding to indicate the primary content slides: 

 

- Slide 1: Title and Authors 

- Slide 2: Introduction transition slide 

- Slide 3: Background justification slide 1 

o Here, you will want to start broad and identify a major problem or issue that your 

study addresses as the main message for the slide (e.g., using information from 

the beginning of the Introduction section of your paper).  

o The supporting content may include a figure from a previous paper, an image, or 

1-2 short bullet points. 

- Slide 4: Background justification slide 2 

o Here, you will want to start narrowing towards content more specific to your 

study as the main message for the slide (e.g., using information from the middle 

of the Introduction section of your paper).  

o The supporting content may include a figure from a previous paper, an image, or 

1-2 short bullet points.  

- Slide 5: Hypothesis slide 

o Here, you will want to list your hypotheses. 

- Slide 6: Methods transition slide 
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- Slide 7: Methods slide 

o Here, you will want to list what you did for your study. 

o You might include an image of the study or study organism to support this 

content. 

- Slide 8: Results transition slide 

- Slide 9: Results slide 

o Here, you will want to state your main results as the main message of the slide.  

o You will likely want to use a figure to support this message here. 

- Slide 10: Discussion transition slide 

- Slide 11: Discussion slide 1 

o Here, you will want to put your results in context, starting narrow and specific to 

your study. The main message of this slide might state whether your hypotheses 

were confirmed or rejected.  

o The supporting content could address the possible reasoning for this. 

- Slide 12: Discussion slide 2 

o Here, you will put your results in context of bigger picture issues (e.g., those 

addressed in Slide 3). The main message should state how your results impact (or 

do not impact) those issues.  

o The supporting content on the slide might provide details as bullet points or use 

an image to help visualize the message. 

- Slide 13: Conclusion slide 

o The main message of this slide should be the primary conclusion from your study. 

o The supporting content may emphasize impacts on “big picture” issues and/or 

include ideas for future work. 

 

You will be provided a PowerPoint template with this format. Note that this is only a 

recommendation and you are welcome to alter this format to best fit your presentation. 

 

Citing other work in your presentation 

You can include previous work in your presentation. This might be particularly helpful in the 

Introduction to help justify your study. You do not need a full citation list, but should include the 

authors and year of any study you reference in your oral presentation. This is similar to an “in-

text” citation in your paper and can be included at the bottom of any slide that uses that 

information (see template for reference). 

 

Notes on colors, fonts, artwork, and animations 

For scientific presentations, simple styles are often better than complex ones for conveying your 

message. Complex colors, fonts, artwork, and animations typically only distract an audience 

away from your main message.  

 

For colors, pick schemes with high contrast for increased visibility. For instance, a white 

background with dark lettering works well. 

 

For fonts, pick a simple sans-serif font such as Arial, Helvetica, or Calibri that is easy to read. 

Also, use a large font size that can be read from far away. 
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For artwork, pick something that is simple and conveys your point quickly without a lot of time 

spent describing the image. 

 

For animations, don’t use them. They are distracting. 

 

In class today, you will work on creating the slides for your presentation next week. 
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Assignment: Daily Assignment #9 

Due: beginning of next week’s class 

 

In this assignment, you are asked to: 

1. In groups, critique the slides provided to you by your TA. In you critique, you should 

indicate at least one issue per slide and a suggestion for alleviating the issue. You will 

present your critique to the class as a group. 

2. Create the slides that you will use for your presentation next week. You will have time in 

class to work on these and you must go over your progress with your TA before leaving 

class. 

 

Rubric 

1. Did student provide a critique of the slides provided to them and suggestion for 

improvement and present this to the class? (20 points) 

2. Did student go over slides before leaving class? (20 points) 

3. Did slides answer why the study was done? (10 points) 

4. Did slides answer how the study was done? (10 points) 

5. Did slides indicate what was found in the study (10 points) 

6. Did slides place the findings in a broader context? (10 points) 

7. Did slides have appropriate use of text and visual aids that were not overbearing? (10 

points) 

8. Was font, color, and artwork appropriate and easy to read? (10 points) 

  



 56 

Lab 14: Presentations 

 

Schedule 

• Group presentations (90 minutes) 

o 8 minutes maximum per presentation 

o 2 minutes for question and answer following each presentation 

o 5 minutes for setup prior to each presentation 

• Fill out peer evaluation form (10 minutes) 

• Discussion of final assignments (TA; 10 minutes) 

 

Preamble 

This week, you will be presenting your findings as a group. A rubric for these presentations is 

provided on the next page. 

 

Note that you will also need to complete Daily Assignment 10 and turn in your final paper by the 

end of next week. Rubrics for these are provided below. 
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Final Oral Presentation Rubric 

 

- Title slide (10 points) 

o Was the title appropriate and convey the main message of the study? (5 points) 

o Were all group members listed and introduced? (5 points) 

- Introduction slides (20 points) 

o Was previous information used to provide the basis for the study? (10 points) 

o Were past studies cited? (5 points) 

o Were hypotheses presented? (5 points) 

- Methods slides (10 points) 

o Was the experimental design explained? (5 points) 

o Was the measurement and analytical design explained? (5 points) 

- Results slides (10 points) 

o Was the main result clearly stated? (5 points) 

o Was a visual aid used to help support the main result using data? (5 points) 

- Discussion slides (20 points) 

o Were results compared to hypotheses? (5 points) 

o Were results compared to previous studies? (5 points) 

o Was main conclusion stated? (5 points) 

o Were options for future studies discussed? (5 points) 

- Slide design (15 points) 

o Were slides free of extraneous content that was not discussed? (5 points) 

o Were slides free of distracting elements? (5 points) 

o Did slides convey the main message effectively? (5 points) 

- Verbal presentation quality (10 points) 

o Were presenters audible? (5 points) 

o Did presentation stay within the time limit (5 points) 

- Answers to questions (5 points) 

o Did the group make an earnest attempt to answer any and all questions? (5 points) 
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Assignment: Daily Assignment #10 

Due: beginning of next week’s class 

 

Take pre-assessment survey 

• This should be done on Blackboard. 

• Please answer to the best of your knowledge without looking anything up. You will only 

be graded for completeness. 
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Rubric for Final Papers 

 

- Title page (5 points) 

o Was the title appropriate and convey the main message of the study? (3 points) 

o Were all group members listed as authors? (2 points) 

- Introduction (15 points) 

o Did students follow the assigned structure for the Introduction? (5 points) 

o Were there citations to back up each claim in the Introduction? (5 points) 

o Were the hypotheses correctly written and logical? (5 points) 

- Methods (15 points) 

o Did the Methods include enough information to be able to repeat the experimental 

design and trait measurements? (5 points) 

o Did Methods appropriately explain how the statistical analyses were done? (5 

points) 

o Was the Methods written in past tense and was there a logical flow? (5 points) 

- Results (15 points) 

o Did the Results include a table with correct data? (5 points) 

o Did the Results include a figure with correct data and legend? (5 points) 

o Were the Results from the table and figure interpreted correctly? (5 points) 

- Discussion (25 points) 

o Were the connections in the Discussion made correctly to the hypotheses? (5 

points) 

o Were the connections in the Discussion made correctly to previous studies? (5 

points) 

o Were the connections in the Discussion made correctly to an ecosystem service? 

(5 points) 

o Were at least two limitations listed and was it stated how they impacted the 

interpretation of the results and possible methods alleviate these limitations with a 

future study? (5 points) 

o Did conclusion paragraph summarize aspects of each of the first four Discussion 

subsections? (5 points) 

- References (10 points) 

o Were all in-text citations written correctly in APA format? (5 points) 

o Were all references listed in APA format? (5 points) 

- Paper design (15 points) 

o Were complete sentences used? (5 points) 

o Was the paper mostly free of major grammatical and English language errors? (5 

points) 

o Were sections titled correctly and in the correct order? (5 points) 
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Peer Evaluation 

 

Below, please list the names of each of your group members and evaluate them on a 0-5 scale for 

their participation in the group project over the course of the semester. The default score for a 

group member that contributed fairly to the project is a 5. If each group member provided fair 

effort, please give everyone a 5. Note that you will be asked to score yourself. 

 

Please use the information below to help with your scoring. 

 

Score breakdown 

5 – Group member contributed a fair amount of effort to the group project and did not fail to 

contribute items that were asked of them. 

 

4 – Group member contributed 80% of what the others in the group contributed, including items 

that were asked of them. 

 

3 – Group member contributed 60% of what the others in the group contributed, including items 

that were asked of them. 

 

2 – Group member contributed 40% of what the others in the group contributed, including items 

that were asked of them. 

 

1 – Group member contributed 20% of what the others in the group contributed, including items 

that were asked of them. 

 

0 – Group member did not contribute to the project at all. 

 

Scoring table 

 

Name Score 

[Your name] 
 

  

  

  

  

  
 

 

 


